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ENVIについて
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ENVI概要
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ENVI: ENvironmental for Visualizing Images
✓ユーザフレンドリーなインターフェース
✓空間データの処理と解析をするソフトウエア
✓快適なハイパースペクトルの解析処理
✓大容量データのハンドリング
✓定評ある解析アルゴリズムを多数搭載
✓ワークフロー機能による簡易な画像処理
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ENVIのオプション機能
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モジュール名 内容

Atmospheric Correction マルチ・ハイパースペクトル画像の大気補正を行うモジュールです。画像
内の大気の影響を除去します。

DEM Extraction ステレオペア画像から標高データ（Digital Elevation Model）を抽出するモ
ジュールです。

Feature Extraction オブジェクト分類法のモジュールです。従来のピクセル値の統計から分類
する方法と異なり、ユーザの求めるオブジェクト（車、屋根、河川、湖
等）を画像から抽出します。
また、点群データ解析ツールであるENVI LiDAR ではこのモジュールを使用
することで建物、木、鉄塔などのオブジェクトを抽出することができます。

Feature Extractionモジュールによる道路の抽出
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ENVIのオプション機能

4

モジュール名 内容

Photogrammetry 対応衛星画像からオルソモザイク画像を作成するためのモジュールです。
ステレオペア画像を使用することで3 次元点群データの生成も行うことが
できます。

NITF NITF データの読み込み、書き込みをサポートするモジュールです。

ENVI Crop Science 衛星画像やUAV / ドローンなどで取得したマルチスペクトル画像を用いて、
圃場の健康状態や作物の数量把握を簡単に行うためのモジュールです。

SARscape 合成開口レーダ（SAR）画像の解析処理を行うためのモジュールです。基
本的な処理や干渉解析に加え、追加のオプションを加えることで時系列解
析や偏波解析も行うことが出来ます。

Deep Learning TensorFlowを使用して深層学習モデルをトレーニングし、空間特性とスペ
クトル特性に基づいて画像内のフィーチャを特定します。（※動作には
ハードウェア要件あり）
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ENVIの利用事例:防災 -地形図の作成

長野県林業総合センターは、昨今の山地災害の被害を
減らすべく、土砂災害危険地発見のための地形判読を
容易に行うために新たな立体図法、長野県型立体地形
図=CS立体図を開発しました。ENVI LiDARを使用し、
その地形図を作成する元となる高解像度DEM （数値
標高モデル：Digital Elevation Model）を大量な航空
レーザ測量データから抽出しています。

• CS立体図法とは、以下を算出・着色した図法。
- 標高や傾斜、勾配変化を視覚情報から直感的に読み
取ることができます。

1. DEMから曲率（Curvature）と傾斜（Slope）を算
出

2. 谷（凹）地形を青色
3. 尾根（凸）地形を赤色
4. 緩斜面を淡い色、急斜面を濃い色で段彩化
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CS立体図

出典：長野県林務部
長野県森林整備加速化・林業再生協議会路網部会,

『長野県型立体地形図=CS立体図』を用いた林内路網の路網配置検討手順
P6, 2014年3月
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ENVIのリソース

ENVI Discussion
• ENVI Discussion は当社ホームページ上に設けられており、ユーザ同士が問題の討議や意見の交換が行えます。

• https://www.nv5geospatialsoftware.com/Support/Forums/aff/216

GitHub
• 米国本社によって管理・運営されているGitHub のページでは、ENVI の機能拡張に関する様々なコードが公開され
ております。

• https://github.com/envi-idl
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https://www.nv5geospatialsoftware.com/Support/Forums/aff/216
https://github.com/envi-idl
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問い合わせ先

NV5 Geospatial 株式会社では、ENVI 及びその他の製品に関する技術サポート、お
客様の使用事例などの情報を提供しています。
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NV5 Geospatial 製品・サポート連絡先
E-mail：
support_jp@NV5.com
Home Page：
https://www.nv5geospatialsoftware.co.jp/

mailto:support_jp@NV5.com
https://www.nv5geospatialsoftware.co.jp/


ENVIの起動とUI
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ENVIの起動方法
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Windows10 / 11
[Start Menu] > ENVI 6.1 > ENVI 6.1

Mac
/Applications/NV5/ -> ENVI6.1のアイコンを選択

Linux
ターミナルから envi_rt コマンドを入力する
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ENVIインターフェースについて
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ツールバー

カーソル値表示

プロセスバー

メニューバー

レイヤマネージャ

オーバービュー
ツールボックス
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ENVIインターフェース: メニューバー

• ファイルを開く、編集、表示に関する
ツールや、ウィンドウの分割など、イン
ターフェース及び、画像の基本的な操作
に必要な機能を提供します。
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ENVIインターフェース: ツールバー

• ズームイン・アウトや、パン、アノテーション、ストレッチなど、表示した画像
に対して操作に関するツールをグラフィカルなアイコンで提供します（詳細は後
述します）。
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ENVIインターフェース: レイヤマネージャ

• インターフェースに表示されている画像の管理を行い
ます。

• チェックボックスをオン/オフする事で、表示/非表示の
設定を行います。

• ファイル名上で右クリックをすると、サブメニューが
表示され、表示の削除やRGBコンポジットの変更など
が行えます。

• レイヤーマネージャの[Overview]へチェックを入れる
ことで、画像全体を表示します。
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ENVIインターフェース:ツールボックス

• ENVI の解析機能がカテゴリごとに格納されています。検索機能が提供されてお
り、「Search the Toolbox」へキーワードを入力することで、該当の機能がリスト
表示されます。
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ENVIインターフェース:
カーソル値表示およびプロセスバー
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地図投影法を保持した画像上でマウスを移動させると、カーソルのある場
所のピクセルに対応した地図情報が表示されます。

プロセスバーは、処理の経過を表示しています。右側にあるバツマークを
クリックすると、処理はキャンセルされます。
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ENVI HELP

• 指定のブラウザでENVIのHELP機能が起動します。
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一見してわかる通り、英語版のみが提供されている。
日本語でHELPを参照する方法は、大きく2通りある。
1. 日本語パッチを適用する
2. WebブラウザでDocumentation Centerにアクセスしアドオンで翻訳する
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ENVI HELP（日本語）

• 特定のバージョンでは、ENVIの日本語パッチが提供されています
-現在最新の日本語パッチ提供バージョンは、ENVI6.0です。

- ENVI6.1は将来的に日本語パッチが提供される可能性があります。

• 日本語パッチを適用すると、表示されるHELPも弊社で翻訳した日本語版のもの
になります
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DOCUMENTATION CENTER

• ENVIのHELP機能と同じ内容のものが本社のDocumentation Centerで提供されて
います。

• ブラウザによっては翻訳アドオンを適用することが可能なので、機械翻訳によっ
て大まかな意味を捉えるのであればこの方法が便利です。

https://www.nv5geospatialsoftware.com/docs/home.html

18

https://www.nv5geospatialsoftware.com/docs/home.html


ENVIの操作
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環境の設定: PREFERENCE

• 使用するデータへのアクセスなどを容易に行うため、環境の設定を行います。

• ENVI では、ファイルの入出力ディレクトリをあらかじめ指定することで、デ
フォルトで指定したディレクトリを表示することが可能です。

20
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環境の設定: PREFERENCE

21

名称 機能

Input Directory 入力ファイルを指定する際に表示するインプットディレクトリの指定

Output Directory 出力ファイルを指定する際に表示するインプットディレクトリの指定

Temporary Directory 処理中に作成される、テンポラリファイルの保存先

Auxiliary File Directory 読み取り専用のDVD などからデータを読み込む際に、ヘッダファイルが
書き込めない場合の保存先

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director


ENVI入門

ファイル読み込み

• ENVI にラスタデータの読み込み、表示を行います。

• この演習では、Copernicus Open Access Hubより入手したSentinel-2のデータを
読み込み、表示を行います。

22

MTD_MSIL1C.xml
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MTD_MSIL1C.XMLについて

• Sentinel-2 データを入手したときに
画像データと共に配布されるメタ
ファイル

• このメタファイルには、画像撮影時
の情報やデータ処理施設で使用され
たデータ処理のパラメータが含まれ
ています。

• ENVI ではこのメタファイルを直接
指定することで、ENVI ファイルと
同様に取り扱うことができ、波長帯
の情報や地理情報などを合せて読み
込むことが可能です。
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SENTINEL-2ミッションについて

• Sentinel-2ミッションは、植生、土地被覆、
環境モニタリングをサポートするために開
発された2つの衛星で構成されている。
- Sentinel-2A衛星は2015年6月23日にESAに
よって打ち上げられ、10日間の繰り返し周
期で太陽同期軌道で運用されている。2機目
の同じ衛星（Sentinel-2B）は2017年3月7日
に打ち上げられた。これらを合わせて、地
球のすべての地表、大きな島、内陸および
沿岸海域を5日ごとにカバーしている。

• Sentinel-2 Multispectral Instrument (MSI)は、
290kmの軌道幅に沿って可視近赤外
（VNIR）から短波長赤外（SWIR）までの
13のスペクトルバンドを取得する。

https://sentinels.copernicus.eu/web/sentin
el/user-guides/sentinel-2-
msi/resolutions/spatial

24

Band 
Number

Central Wavelength 
(nm)

Bandwidth (nm)
Spatial Resolution 

(m)

1 443 20 60

2 490 65 10

3 560 35 10

4 665 30 10

5 705 15 20

6 740 15 20

7 783 20 20

8 842 115 10

8a 865 20 20

9 945 20 60

10 1375 30 60

11 1610 90 20

12 2190 180 20

※ENVI上では、異なる解像度のデータは別々のオ
ブジェクトとして読み込まれます。これは後続の
Data Managerの演習で確認できます。

https://sentinels.copernicus.eu/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
https://sentinels.copernicus.eu/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
https://sentinels.copernicus.eu/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
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VIEW METADATA

• データが開かれたら、レイヤマ
ネージャで右クリックしView 
Metadataを選択して詳細を確認し
てみます。

• データのサイズや型、設定されて
いる投影情報や波長情報が確認で
きることがわかります。
- ENVIがサポートしている衛星の
メタファイルを指定して画像を開
いた場合、ファイルに記載されて
いる投影情報や波長情報が併せて
読み込まれます。

- 現在読み込まれているデータが、
実数（浮動小数点）、符号付もし
くは符合無しの整数型かどうかを
理解することは、データ解析をす
る上で重要になります。（詳しく
はBand Mathの演習で触れます）

25
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ディスプレイツール

ツールバーで提供されているツールを使用して、表示した画像に様々な操作を行う
ことができます。

• Cursor Value

-十字が交差するポイントのピクセル値や緯度経度を確認できる

• Arbitrary Profile

-始点と終点を指定すると、その間のピクセル分布を確認できる

26https://www.nv5geospatialsoftware.com/docs/DisplayTools.html

Cursor Value Arbitrary Profile

https://www.nv5geospatialsoftware.com/docs/DisplayTools.html
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3ボタン式マウスによる移動の簡略化: 
パン機能とズーム機能について

27

クリック

前後回転
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ストレッチの調整

• 表示した画像に対して、ストレッチやコントラストなどを変更して、画像を見や
すくします。

• データを読み込んだ際にRGB コンポジットで表示されている画像があるので、そ
の画像を使用して操作を行います。

28
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ストレッチとは？

29

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

各ピクセルには様々な値が入っており、上に示すような分布だとします。
（値の取る範囲は、データがどのような型を持つかに依ります。詳細は後述します。）

0 65535
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

まずはENVIで表示するにあたって、データ値を輝度値(0から255のBYTE値)に変換します
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

全体的に暗いので、
この辺りで見え方を
調整し直したい
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
この範囲で明るさを
再度調整した
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
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ストレッチの実施

ENVIのストレッチ機能には、変換方法が幾つか用意されています

• ここではOptimized LinearからGaussianに変更します

• その他のストレッチ手法について:
- https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html

35

Optimized Linear Gaussian

https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html
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ストレッチの実施（VIEWエリアで最適化）

1. ボタンで全体を表示し、
 ボタンで富士山頂を拡大し
ます

2. ボタンで、表示したエリア
についてストレッチを適用しま
す

3. ボタンをクリックして拡大/
縮小による自動更新を有効に設
定します

4. ボタンで、全体に対して再
度ストレッチを実施します

36

Stretch on View Extent
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補足: ヒストグラムストレッチ

• ストレッチしたい範囲をユーザ側で任意に決めるには、ヒストグラムストレッチ
という機能を使用します

37
https://www.nv5geospatialsoftware.com/docs/displaytools.html#InteractiveStretching

https://www.nv5geospatialsoftware.com/docs/displaytools.html#InteractiveStretching
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データマネージャ

Data Manager は読み込んだファイルを管理しています。

• レイヤーマネージャでは、表示している画像の情報しか表示されません。

• データの詳細情報を確認する時や、すでに読み込んだデータを別の表現(バンドのグレイスケール
表示や、RGB コンポジットの変更など)で表示する際にこのマネージャを使用します。

https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager

38

OPEN

Data Manager Layer Manager
ENVI View

https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager
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データマネージャ: 演習

1. メニュー → File → Data Manager 
を選択してください。

2. Data Manager ダイアログ → 
「10m-S2MSI1C 2020-05-02 
01:27 T54STE」の[Band 8]を右ク
リック → Load Grayscale を選択
してください。
- ここでみてわかる通り、ENVIでは
同じSentinel-2のデータであっても、
異なる解像度のデータを別々のオブ
ジェクトとして管理しています。

3. Band 8 が表示され、レイヤーマ
ネージャへ追加されていることを
確認してください。

39
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カラーの変更

前の項目で表示したBand8 のグレイスケールの画像に対して疑似カラーを付与しま
す。

• グレイスケールの画像には、カラーテーブルを割り当てることで、データの分布
を一目で確認することが可能です。

• 疑似カラーを付与する機能として、「Change Color Table」と「Raster Color 
Slices」のツールがあります。

40
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CHANGE COLOR TABLE

1. レイヤーマネージャ → グレ
イスケール画像の「10m-
S2MSI1C 2020-05-02 01:27 
T54STE」を右クリック → 
Change Color Table 
→Rainbow を選択します。

2. カラーテーブルを選択すると、
選択したカラーテーブルによ
り色づけされた画像がディス
プレイに表示されます。

適用している疑似カラーは、
データの実際の各ピクセル値に
対してではなく、ストレッチさ
れた後の見え方に対して適用さ
れています。

• ストレッチを変更すると、色の
当たり方が変わることを確認し
てください

41

0 0 0
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Linear Stretch (Rainbow)
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RASTER COLOR SLICE

1. データマネージャ → 「10m-S2MSI1C 
2020-05-02 01:27 T54STE」のB8を右
クリック → Load Raster Color Slice を
選択します。

2. New Default Color Sliceボタン か
ら、カラー適用範囲を適当なものに変
更します。

3. Edit Raster Color Slicesウィンドウの
設定を確認し、OKボタンで閉じます。

このカラーは、実際のピクセル値に対して
適用されています。

• ストレッチの変更自体が不可能であるこ
とを確認してください。

42https://www.nv5geospatialsoftware.com/docs/ColorSlices.html

https://www.nv5geospatialsoftware.com/docs/ColorSlices.html
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RGBコンポジット: 背景

• 衛星は、光源(太陽)からの電磁波が地表面の物質を反射してセンサに戻ってくる強さ(電
磁波の強さ)を観測します。
- 地表面の物質は、それぞれ違った反射の特徴があり、衛星の各バンドは波長帯域が違う電磁波
を取得することから、地表面の反射の特徴をとらえることができます。

• これを利用し、RGB へ割り当てるバンドを変更することで、地表面の特徴を一目で認識
できるように表示します。
- 以下の図は、各波長帯における地表面の物質(植物、土、水)の電磁波の反射と放射の強さを示
しており、横軸は電磁波の波長を、縦軸は反射・放射の強度を示します。

43

各波長帯における植物、土、水の電磁波の反射と放射の強さ[JAXA]
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RGBコンポジット: トゥルーカラー合成

• 衛星データは様々な波長帯で収集され
ている。

• 個々のデータはシングルバンドのグ
レースケール・データであるが、
ENVIはそれらにRGBの色を付加し、
合成として表示することができる。

• 青色波長帯で取得されたデータには青
色チャンネルを、緑色波長帯で取得さ
れたデータには緑色チャンネルを、赤
色波長帯で取得されたデータには赤色
チャンネルを適用することで、人間の
目で見たような画像を作成することが
できます。
-これをトゥルーカラー合成という。

44

IKONOS, JSI



ENVI入門

RGBコンポジット: フォールスカラー合成

• 同様に、カラー合成を適切なものに変更す
ることで、特定の波長における反射の強さ
を強調することができる。

• 緑色の波長帯で取得したデータに青色の
チャンネルを、赤色の波長帯で取得した
データに緑色のチャンネルを、近赤外線の
波長帯で取得したデータに赤色のチャンネ
ルを適用すると、植生が強調された画像が
得られる。
-これをフォールスカラー合成と呼ぶ

-これは植生が近赤外域で強い反射特性を持
つことを利用している
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ENVI入門

RGBコンポジット：演習

1. メインメニュー →File → Data Manager を選択します。

2. Data Manager ダイアログ → [RGB に該当するBand を選
択] → Band Selectionタグを展開し、RGB コンポジットを
確認します。

3. 組み合わせが決まったら、「Load Data」ボタンをクリッ
クして画像を表示してください。
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演習ではフォールスカラーを作成する

青: Band3 / 緑: Band4 / 赤: Band8



ENVI入門

データの比較

作成されたフォールスカラー画像と、トゥルーカラー
画像を比較します。

• レイヤマネージャのShow/Hideチェックを切り替え
る

• 透過率を変更したいレイヤをレイヤマネージャで左
クリックした後、ツールバーのTransparencyバーを
変更する(右端のスライドバー)

• Viewを分割し、互いにリンクさせる（後述）
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透過率0%

透過率100%



ENVI入門

複数のビューと画像のリンク

• ENVI のインターフェースでは、複数のビューを用いて同時に画像を表示し、
リンクすることができます。

• 画像をリンクさせることで、表示しているデータを効率的に比較します。
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ENVI入門

複数のビューと画像のリンク: 演習

1. メニュー → Views → Create New View を選択し、画像の表示エリアが二つに分割され
たことを確認してください。

2. レイヤーマネージャ → 新しく作成されたView をクリックしてください。

3. Data Manager → Band4 を右クリック → Load Grayscale を選択してください。
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現在アクティブなビューは
緑色の枠で囲われていることから区別できる



ENVI入門

複数のビューと画像のリンク: 演習

4. 新しく作成されたView の[Overview]へチェックを入れ、画像全体も確認してください。
この時点では画像はリンクされていないため別の場所を表示しています。

5. View → Link Views を選択し、表示した二枚の画像のリンクを行います。

6. Link Views ダイアログ → <Link ALL> → <OK> をクリックし、リンクを実行し、比較
します。
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この演習では地理情報を利用して
リンクを行う[Geo Link]を選択します。
ピクセルポジションを利用し
リンクを行う場合は、 
[Pixel Link]を選択してください。



ENVI入門

画像を閉じる

• 表示している画像を閉じ、必要がなくなった
View を閉じることが出来ます。
-個々のレイヤはレイヤを右クリックし、

Removeで閉じます

- Viewを削除する場合はViewを右クリックし、
Remove Viewを選択します

- Viewは残したまま、Viewにあるレイヤを削除
するには Remove All Layersを選択します。
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✓ Layer Managerから削除してもData Managerにはデータが残ります。
✓ 必要のないファイルを閉じる場合は、Data Manager から該当ファイ
ルを右クリック→ Close File を選択してください。



ENVIによる解析
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ENVI入門

前準備: ベクタデータの取り扱い

• ENVIではESRIシェープファイルなどのベクタデータも取り
扱うことができます

- 他のファイルと同じように、メニューバー > Openから開
いて表示ができます

• ENVIでは、ベクタデータは主に以下の用途で使われます

- 画像を切り出す際の範囲を指定する

- マスク処理を行う

- ベクタデータと重なる地点のピクセル値から統計処理等を行う

• これから行う解析では、開いているSentinel-2データのエリア
の一部を解析に使用します。

- ENVIでこのシェープファイルを開いて、切り出しエリアを確認
します。
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データ ファイルパス

解析範囲 subsetAoi¥subset.shp



ENVI入門

キャリブレーション

• 一般に配布されているデータは反射された光の強さが記録されています。
-この状態で記録されている値を、デジタルナンバーと呼びます。

• デジタルナンバーは変換係数を使用して放射輝度や反射率といった物理量に変換
することができます。
-この操作をキャリブレーションと呼びます。
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デジタルナンバー 反射率などの物理量

⚫ ENVIがこのキャリブレーションをサポートする衛星は以下にまとめられています 
 https://www.nv5geospatialsoftware.com/docs/RadiometricCalibration.html

⚫ この他にも、プログラムによって独自のキャリブレーションを追加することも可能です。

https://www.nv5geospatialsoftware.com/docs/RadiometricCalibration.html


ENVI入門

キャリブレーション: 演習
1. ツールボックスの検索フィールドへ「radio」と入力しRadiometric 

Calibration をダブルクリックして起動させてください。

2. Input RasterのBrowseボタンを押下し、ファイル選択ダイアログで
「 10m-S2MSI1C 2020-05-02 01:27 T54STE 」を選択し、
<Spatial Subset>をクリックしてください。

3. Spatial Subset ダイアログでは、画像の処理範囲を設定します。
[Subset by Vector]ボタンで開いたシェープファイルを選択し、切
り出し範囲を指定します。

4. ＯＫボタンでダイアログを閉じると、Input Rasterに[Subset]と付
加されたデータが登録されることを確認してください。
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ENVI入門

キャリブレーション: 演習

5. 以下のパラメータ設定に更新し、OKボタンで
ファイル出力してください。

6. Cursor valueツールを使用し、出力された結果
のピクセル値が0.0から1.0の間で登録されてい
ることを確認してください。

-反射率は0.0から1.0で定義された光の反射の
強さを示す物理量です。
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Calibration Type: Top-of-Atmospheric Reflectance
Scale Factor: 1.0
Output Data Type: Float
出力ファイル名: ref.dat



ENVI入門

出力ファイルの確認: ENVI形式とは

ENVI フォーマット(ENVI から作成されるファイル)は、単純なラスタフォーマットのデータです。

• このフォーマットはバイト型で形成され、フラットバイナリファイルと呼ばれるデータフォー
マットです。

• このフォーマットは画像以外のデータが含まれないため、ENVI はENVI ヘッダファイル（ENVI 
Header File：*.hdr ）というASCII ファイルを作成し、そこに画像を読み込むためのパラメータ情
報を記録します。
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• 拡張子なしまたは.dat形式のフラットバイナリデータ
• .hdr形式の関連情報を書き込んだASCIIファイル

【ENVIフォーマットの構成要素】

フラットバイナリデータ

ASCII ファイル



ENVI入門

出力ファイルの確認: ピラミッドファイルとは

ENVIアプリケーションで開いたファイルをエクスプローラで確認す
ると、*.enpという拡張子のデータも同じフォルダ内に存在すること
が確認できます。これは、ピラミッドファイルと呼ばれるデータで
す。

• ENVI は、画像をディスプレイに読み込む際に、各画像のピラミッ
ドを作成します。
- ピラミッドは、さまざまな解像度のデータファイルのコピーです。

- ピラミッドは、画像の大部分を低解像度で表示するときに必要な再サ
ンプリングを減らすことで、画像の表示を高速化するために使用され
ます。

• 元のデータサイズの3分の1ほどの大きさになるため、ストレージ
容量を圧迫している場合には削除することが可能です。再度ENVI
で開いた際に存在しなかった場合、ふたたび作成されます。
- Preferencesから、作成自体を行わないようにすることも可能です。
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ENVI入門

大気補正

• 衛星センサは大気を通して地表を観測しているため、大気中の水蒸気や細かい粒子の影
響を受けています。

• 衛星画像データを定量的に解析するためには、この大気効果を除去して真の地表反射率
を求めることが必要です。
- ここでは、ENVI の標準機能に含まれている散乱や、もやの影響を除去する「Dark 

Subtraction」という手法を使用し、大気の影響を簡易的に除去する補正を行います。
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デジタルナンバー

反射率などの物理量

大気効果を除去した真の物理量

キャリブレーション

大気補正



ENVI入門

大気補正: 演習

1. ツールボックスの検索フィールドへ「dark」と入力
しDark Subtraction を選択してください。

2. Input Rasterパラメータでは、「ref.dat」を選択し
ます。ROIとValuesが空欄である場合、自動で各バ
ンド値の最小値を検出されます。今回はこれらは空
白とします。

3. Output Rasterに dark.dat のフルパスを指定し、OK
ボタンで実行して、レイヤーマネージャへ
「dark.dat」が追加されていることを確認してくだ
さい。
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ダークサブトラクションとは、各バンドから指定した値を一律で差し引くという手法です。
これは、本来反射がないと考えられる部分(陰)からオフセットを計算しています。
差し引く値にバンド毎の最小値を指定すると、処理の結果各バンドの最小値が0になります
(Band Minimum)。



ENVI入門

大気補正: 演習

4. 処理前の画像「ref.dat」と大気補正後の画像「dark.dat」のスペクトルの違いを確認し
ます。Spectral Profileツールを選択し Options → Additional Profiles → Add File で
「ref.dat」を選択して追加を行ってください。
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Dark Subtractionによって各バンドの最小値が0になるように減算さ
れているため、darkのほうがrefよりも値が低い



ENVI入門

RADIOMETRIC CORRECTION ツール

• ENVI に標準機能に含まれる、キャリブレーションや
大気補正のツールはENVI ツールボックスの
「Radiometric Correction」フォルダに含まれます。

- Dark Subtraction

- Flat Field

- Empirical Line

- Internal Average Reflectance

• 一般的に大気補正は、研究所やフィールドより得られ
たグランドトルースのスペクトルデータに基づいて計
算されます。
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https://www.nv5geospatialsoftware.com/docs/atmosphericcorrection.html

https://www.nv5geospatialsoftware.com/docs/atmosphericcorrection.html


ENVI入門

ATMOSPHERIC CORRECTION: 大気補正モジュー
ル

大気補正に関する追加機能を提供するオプションモジュール
FLAASH

• Spectral Sciences, Inc.  (SSI)、Air Force Research Labs  (AFRL)および米国本社の3社で開発され
た、MODTRAN6ベースの大気補正ツールです。

• スペクトルの水分吸収帯の情報から水蒸気量を算定し、反射率に変換します。

• ENVI5.7から大幅なアップデートが行われ、UIが更新されました。

QUAC

• マルチバンド（ハイパースペクトルも含む）、大気補正を簡易的におこなうツールです。

• 放射輝度への変換などの前処理が必要ないため、操作が簡単です。

• 高解像度のマルチバンド画像においてよく使用されています。
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https://www.nv5geospatialsoftware.com/docs/AboutAtmosphericCorrectionModule.html

https://www.nv5geospatialsoftware.com/docs/AboutAtmosphericCorrectionModule.html


ENVI入門

BAND MATH

• 同じファイルのバンド間で演算を行い、新たなファイルを作成します。

• 一般的に知られている数式や係数を与えることで、NDVI（植生指標）など、リ
モートセンシング画像を解析する上で便利な解析結果を求めることが可能です。
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赤色波長で取得したイメージ

近赤外波長で取得したイメージ

NDVI

✓ NDVI は植生の分布状況や、活性度を示す
指標で、-1 から1 の範囲で表されます。

✓ 植生の反応が高い場合は1 に近く、低い場
合は-1 に近い値となります。



ENVI入門

BAND MATH: 演習
1. 大気補正結果である「dark.dat」が開かれている

ことを確認します。

2. ツールボックス → 検索フィールドへ「band」と
入力してください → Band Math を選択し、起動
させてください。

3. Band Math ダイアログが表示されます。Enter an 
expression へ以下の式を入力 → <Add to List>を
クリック → <OK>をクリックしてください。
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(fl𝑜𝑎𝑡 𝑏8 − 𝑏4)/(float(𝑏8) + 𝑏4)

✓ 使用する変数はb始まりで定義します

✓ 型は一番大きいものに併せて計算されるため、元のデータ型に応じ
て型変換(キャスト)することが必要です。

• 整数しか扱えないBYTEやINTEGERでは、商に含まれる小数点以
下が切り捨てられることがあります。

• 例えば0から255からしか扱えないBYTE型では、和差積がこの範
囲から外れると、値が壊れます。



ENVI入門

BAND MATH: 演習

4. Variable to Bands Pairings ダイアログが表示されます。
変数、B4 とB8 にどのファイルのバンドを使用するか設
定を行います。

5. Variable used in expression フィールドのB4 に
「dark.dat」の664μmで取得されたB4由来のバンドを選
択してください。

6. Variable used in expression フィールドのB8 に
「dark.dat」の832μmで取得されたB8由来のバンドを選
択してください。

7. Output Result to を「File」にし、ファイル名を
「ndvi.dat」に設定し、「OK」ボタンをクリックして処
理を実行してください。

8. 表示された結果のピクセル値が-1.0から1.0で定義されて
おり、植生の多い場所で1に近いことをCursor Valueツー
ル等で確認してください。
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ENVI入門

BAND MATH: 補足

• 本処理では、演習のためNDVIの算出は手動で行いましたが、
ENVI にはツールボックスのSpectral → Vegetation フォル
ダ内に簡単にNDVI を算出するツールが用意されています。

- https://www.nv5geospatialsoftware.com/docs/NDVI.html

• そのほか、Band Algebra→Spectral Indicesでは複数の指標
演算の計算をサポートしています。

- https://www.nv5geospatialsoftware.com/docs/spectralindices.h
tml

• ENVIがサポートする指標演算の一覧は以下から確認できま
す。

- https://www.nv5geospatialsoftware.com/docs/alphabeticallists
pectralindices.html

- ここに含まれていないものや、独自の指標を計算する場合に
はBAND MATHツールを使用します。
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Spectral Indicesツール

https://www.nv5geospatialsoftware.com/docs/NDVI.html
https://www.nv5geospatialsoftware.com/docs/spectralindices.html
https://www.nv5geospatialsoftware.com/docs/spectralindices.html
https://www.nv5geospatialsoftware.com/docs/alphabeticallistspectralindices.html
https://www.nv5geospatialsoftware.com/docs/alphabeticallistspectralindices.html


ENVI入門

TIFF形式への変換
これまでの処理ではENVI形式のファイルが出力されていました。

別の画像処理ソフトやプログラミング言語などで扱えるGeoTiff形式に変換する方法を紹介
します。
1. メニュー → File → Save As → Save Raster As…(ENVI, NITF, TIFF, DTED)を選択してください。

2. Select Input File ダイアログ → 「ndvi.dat」を選択 → <OK>をクリックしてください。

3. Save File As Parameters でファイル形式を[TIFF] → 出力ファイル名に「ndvi.tif」を設定 → 
<OK>をクリックしてください。

4. 出力ファイルがレイヤーマネージャへ追加されたことを確認してください。
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ENVI入門

レイヤスタック

• Sentinel-2やLandsat-8のような解像度の異なる
データは、ENVIで読み込んだ際にそれぞれ別
のバンドグループで管理されます。

• これらのデータをまとめて一つのラスタデータ
として扱うためにはレイヤスタック機能を使用
します。

- https://www.nv5geospatialsoftware.com/docs/L
ayerStacking.html

-こうすることで、たとえばSentinel-2で、
MNDWI(修正正規化水指数)のような緑(Band3: 
10m解像度)と短波赤外(Band11: 20m解像度)の
波長帯を使用した指標値計算がBand Mathツー
ルなどから行えるようになります。
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https://www.nv5geospatialsoftware.com/docs/LayerStacking.html
https://www.nv5geospatialsoftware.com/docs/LayerStacking.html


ENVI入門

レイヤスタック: 演習

1. ツールボックスのRaster Management/Build Layer Stackを選択し、
起動させてください。

2. Build Layer Stackダイアログが表示されます。以下の設定を入力
し、OKボタンで処理を実行してください。

3. Data ManagerやView Metadataで結果のメタ情報を確認してくだ
さい。
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✓ Input Rastersには10m, 20mおよび60mのSentinel-2データをそれぞれ設定します。
順番はソートボタン で昇順/降順に自動で並び替えられます。

✓ Grid Definitionは先頭データに依存します。処理時間の関係上、すでに10m
データを切り出して処理している「dark.dat」をFrom Datasetボタン から
選択し登録してください。

✓ Resampling処理はデフォルトのNearest Neighborのままとします

✓ 波長順に並び替えるためのOrder Bands by Wavelengthも必要に応じて設定くだ
さい。

✓ Output RasterはFileボタンに出力設定を併せ、ファイル名は「stacked.dat」と
します。



ENVI入門

機能紹介: TEMPORAL DATA CUBE ツール
ENVI 5.6.3からTemporal Data Cubeという機能が追加されました。

• 同じ地域の異なる日付/時刻を表すバンドで構成されたラスタを構築することができる
ツールです。

• このツールの出力結果は、特定のエリアの時系列的な変化に注目した処理への利用が期
待されます。
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https://www.nv5geospatialsoftware.com/docs/WorkingWithTemporalCubes.html

https://www.nv5geospatialsoftware.com/docs/WorkingWithTemporalCubes.html


ENVI入門

機能紹介: ENVI MODELER

ENVI Modeler はビジュアルプログラミング
ツールです。

• この機能を使用することで、プログラミングす
ることなしにバッチ処理やカスタムワークフ
ローを組み立てて実行することが可能です。

• ここまでで使用してきた個々のツールを組み合
わせ、一連の処理としてひとつにまとめ上げる
ことが可能です。

• 作成した機能はENVIのツールボックスに追加す
ることができます。また、ENVIの作成元である
プログラミング言語のIDLや、Pythonといった
言語のソースコードとして出力することが可能
です。
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https://www.nv5geospatialsoftware.com/docs/VisualProgrammingENVIModeler.html

https://www.l3harrisgeospatial.com/docs/VisualProgrammingENVIModeler.html


ワークフロー①: 分類処理
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ENVI入門

ワークフロー

• ENVIは、操作ガイドに従って進めるだけで簡単に解析結果を導くことができる
ワークフロー機能を多数搭載しています。
-画像処理の専門知識が無くても、科学的根拠に基づいた解析結果を手軽に得ることが
できます。

• ワークフローに搭載されているプレビュー機能を利用することにより、データ全
体へ解析処理を施す前に、設定したパラメータに基づく解析結果を部分的に表示
できます。
-パラメータの再調整などを行えるので、大容量のデータでも一度の処理で最適な解析
結果を得ることが可能になります。
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ENVI入門

分類処理

• ENVIでは、教師付き・教師なし分類を行うためのワークフローが用意されていま
す。
-この演習では教師付き分類を使用してENVIのワークフローを体験します。
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教師付き分類

入力データと分類ラベルを

セットで与えて分類させる方法

教師なし分類

入力データだけを設定して

自動的に分類させる方法

水域

植生

裸地

自動で5通りに分類して



ENVI入門

分類処理: 演習

1. ツールボックス → 検索フィールドへ「class」と入力
してください → Classification Workflow を選択し、
起動させてください。

2. File Selection ダイアログが表示されます。<Browse>
をクリック → 「dark.dat」を選択 → <OK>をクリッ
クしてください。File Selection ダイアログの<Next>
をクリックし、次の手順へと進んでください。

3. Classification Type ダイアログでは、[Use Training 
Data]を選択してください。No Training Data は教師
なし分類を実施します。
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補足:トレーニングデータの作成方法

ポリゴンROI を使用してトレーニングデータを作成します。クリックで3つ以上の
頂点を作成し、ポリゴンを確定する際は、右クリックのメニューからComplete and 
Accept Polygon を選択してください。
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左クリック

左クリック

左クリック

適当なところで右クリックし、
Complete and Accept Polygon を選択

✓ 押し間違えたなどの理由
で操作をやり直したいの
場合には、Clear Polygon
を選択します。

✓ 一度Acceptされたポリゴ
ンは、ワークフローのな
かでキャンセルすること
はできません。やり直す
ためには、改めてClassか
ら作り直す必要がありま
す。

注意



ENVI入門

分類処理: 演習

4. Define Training Data ダイアログでは、ポリゴンを使用してトレーニングデータを作成
します。ポリゴンを作成するトレーニングデータを選択し、マウスカーソルが十字に
なっていることを確認してください。
✓veg (植生)、snow (雪)、soil (土壌)、water(水域)のトレーニングデータを画像から取得してく
ださい（ここでは、各データごとに2-3ポリゴンずつ程度作成してみます / 小さいポリゴンの
みだと計算に必要な情報が集まらない可能性があるので、やや大きめに取ります）。

✓プロパティでは、トレーニングデータの色の指定と名前の変更が行えます。
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新たなクラスはここか
ら追加できます

クラス名はここで変更
し、Enterキーで確定で
きます。
(注意)
日本語といったマルチ
バイト文字は、クラス
名に使用しないでくだ
さい。
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分類処理: PREVIEWとALGORITHMタブについて

• Previewを使用することで、分類処理の
結果を一部表示することができます。
-結果を見ながら、教師データを取り直す
などの処理が可能です。

- Preview範囲が広いと計算できないので、
ズームインして範囲を狭くして下さい。

• Algorithmタブからは別のアルゴリズムや
パラメータ変更を行うことが可能です。
-選択可能なアルゴリズムの背景について
は以下のURLをご参照ください

- https://www.nv5geospatialsoftware.com/
docs/Classification.html#ClassSupervise
d
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https://www.nv5geospatialsoftware.com/docs/Classification.html#ClassSupervised
https://www.nv5geospatialsoftware.com/docs/Classification.html#ClassSupervised
https://www.nv5geospatialsoftware.com/docs/Classification.html#ClassSupervised


ENVI入門

分類処理: 演習

5. Refine Results ダイアログでは、
ノイズ除去を行います。
✓スムージングの値とアグリゲー
ションの値を調整し、ノイズのよ
うに細かく分類された箇所が無く
なるように調整してください（こ
こではデフォルトの値で進めま
す）。

✓ [Preview]へチェックを入れること
で、処理の結果をその場で確認す
ることが可能です。調整が終了し
ましたら、<Next>をクリックして
ください。
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ENVI入門

分類処理: 演習

6. Save Result ダイアログでは、処理結果のラスタ及びベクタデータの出力先を指定しま
す。チェックがついているものは出力されます。出力先と出力ファイル名を確認後、
<Finish>をクリックしてください。

7. 処理が完了し、レイヤーマネージャにこれらの結果が追加されていることを確認して
ください。
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項目 指定パス

Export Classification Image C:¥training¥output¥dark_class.dat

Export Classification Vectors C:¥training¥output¥dark_vectors.shp



ENVI入門

分類画像に対する後処理

• 出力結果は、「クラス画像」と呼ばれる分類
データです。

• ENVIツールボックスの Classification > Post 
Classification配下には、こうした分類結果に対
する様々な処理がまとめられています。

• 分類結果に対して修正を加えたり、分類結果を
使用して分類元データに対して統計処理を実施
することが可能です。
-ここでは、統計処理のやり方を確認します。
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クラス統計: 演習

1. ツールボックス Classification→Post Classification配下
の「Class Statistics」を選択し、起動させてください。

2. Input Rasterには、実際に統計値を計算する、クラス分
類画像の作成元になった「dark.dat」を指定します。

3. Input Classification Rasterには、クラス分類画像
「dark_class.dat」を設定します。

4. 統計値を計算するクラスは、Unclassified以外のすべて
のクラスを選択します。

5. 共分散やヒストグラムについても計算した場合には、
Compute CovarianceやHistogramsをYesに設定します。

6. 結果をjsonファイルとしてファイル出力したい場合に
は、Output Reportを設定してください。

7. OKボタンで処理を実行します。
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ENVI入門

クラス統計: 結果の確認

84

作図する対象は
Select Plotで変更できます。
結果を画像保存するには
Exportボタンを選択します。

下部の表は
Select All        を選択し
その後Copy        すれば
クリップボードに
コピーされます。
結果をExcelなどに貼り付けて
任意の作図を行うことも
可能です。



ENVI入門

クラス統計: 結果の確認

• Jsonファイルとして出力している場合、各クラス名に対応した統計値が以下のよ
うに記録されたものが出力されます。
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ワークフロー②: 差分抽出
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差分抽出

• 2017年に発生したペルーの洪水災害を対象として差分抽出を行います。

• このインプットデータはSentinel-2の災害前後データをそれぞれBuild Layer Stack
ツールでまとめたものを使用します。
-同様のデータの入手方法については対応するチュートリアルページを参照ください。
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データ ファイルパス

2017年2月20日撮影
Sentinel-2データ

changeDetection¥MalaRiver_2017-02-20.dat

2017年3月12日撮影
Sentinel-2データ

changeDetection¥MalaRiver_2017-03-12.dat

2017年3月17日、ペルー・リマ市フアチパ地区で発生した大規模
な地滑りと洪水後の空撮映像(出展: The Atlantic)
https://www.theatlantic.com/photo/2017/03/peru-suffers-worst-
flooding-in-decades/520146/



ENVI入門

差分抽出: 演習

1. MalaRiver_2017-02-20.datとMalaRiver_2017-03-
12.datのデータを開いてください。

2. ツールボックス → 検索フィールドへ「change」と
入力してください → Change Detection Workflow を
選択し、起動してください。

3. Select Dataパネルでは、Input Raster 1に2/20のデー
タを、 Input Raster 2に3/12のデータをそれぞれ設定
してください。

4. [Next >>]ボタンを押して次の工程に進みます。
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差分抽出: 演習

5. Image Registration パネルでは、2枚の画像の位置合わせを行うことができます。
すでに位置合わせされているならば、Skip Image Registrationを選択します。こ
こでは、ペアは位置合わせ済みのため、この工程はSkipします。
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この位置合わせの工程はデフォルトのパ
ラメータ設定に基づいて実行されます。
もし細かいパラメータ設定の行ったうえ
で位置合わせ処理を実行したい場合には、
Image Registration Workflowという、それに
特化した専用のツールをご利用ください。



ENVI入門

差分抽出: 演習

6. 次のCalculate Changeパネルでは、いく
つかの手法の中から適用するものを選択
できます。ここでは、Layer Stackの演習
で使用した MNDWIの変化に注目します

7. Methodを[Vegetation Index Difference]、
Indexの設定を[Modified Normalized 
Difference Water Index]を選択してくださ
い。
- Previewボタンをアクティブにすると、結果
を確認することができます。

-水指標 MNDWIは、洪水被害を受けたエリ
アで増加することが予想される指数です。
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ENVI入門

差分抽出: 演習

8. Thresholdパネルでは、一定の値以上の
変化量だけを抽出するためのしきい値
が設定できます。画像内の黒い領域は、
関心のない領域としてマスクされます。
デフォルト設定のままNextで先に進め
ます。(次の工程で結果を表示するには
Display resultにチェックを入れておき
ます)
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ENVI入門

差分抽出: 演習

9. Vectorize Changesパネルでは、変化したエ
リアの周囲でポリゴンを作成する方法につい
て定義します。(いずれもデフォルト値のま
ま、Nextで次に進めます）
-Minimum Pixelには、考慮する奇数を指定しま
す。この値よりもピクセル数が少ない領域は、
出力シェープファイルで破棄されます。最小値
は 0 ピクセル、デフォルト値は3です。

-平滑化のためのSmooth Kernel Sizeには、奇数
を指定します。最小値は 0 ピクセル (平滑化な
し)、デフォルト値は3です。
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ENVI入門

差分抽出: 演習

10. 最終工程のExport Resultsパネルでは、出力するファイルを選択できます。Classification 
Rasterに適当なファイル名を設定して、Finishで処理を完了させてください。(出力不要な
データのチェックは外します)
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Pre Post Post + class image



ENVI入門

その他のワークフロー:
位置合わせ(IMAGE REGISTRATION) 

• 差分抽出ワークフローのなかで行える
位置合わせの工程は、より詳細なパラ
メータ設定ができるImage 
Registration Workflowとして独立して
います。

• ツールの中では自動取得されたタイポ
イントを手動で追加・調整することが
できるため、より厳密に位置合わせが
求められるケースでは、このツールが
有効な場合があります。
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ENVI入門

拡張機能の紹介

ENVIでは、IDLやENVI Modelerによって作成したオリジナルの機能やバッチ処理を
ENVIツールボックスに登録し使用することが可能です。

• 日本法人でも、いくつかのオリジナルツールを提供しています。
-例: GSI-DEM Importツール：

• 国土地理院のDEM（基盤地図情報数値標高モデル： JPGIS(GML)形式）を複数枚結合し、
ラスタ形式でENVIに出力するツールです。

• 機能の入手方法や詳細については、support_jp@NV5.comまでご連絡ください。
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https://fgd.gsi.go.jp/download/menu.php


ENVI入門

さらに学習したい人のために
• ENVIでは、チュートリアルとして様々な演習を提供しています。

- https://www.nv5geospatialsoftware.co
- https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials

• トレーニングデータは米国本社のサイトからダウンロードすることが可能です。（以下の図）
- https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials
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チュートリアルデータは、
こちらのリンクをクリックすることで
ダウンロードできます。

https://www.nv5geospatialsoftware.co/
https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials
https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials


ENVI入門

質疑応答

• 本日のトレーニングや全体を通して、疑問点があればご質問ください。

• トレーニング終了後に思いついた質問などあれば、以下の連絡先までご連絡くだ
さい。
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NV5 Geospatial 製品・サポート連絡先
E-mail：
support_jp@NV5.com

mailto:support_jp@NV5.com
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